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Windows:
Pentium III or higher
Win 98/NT/2000/ME/XP
Internet Explorer 5 or higher

System Requirements

Introduction
Welcome to Recipes4Success!

This user guide will walk you through the initial installation and activation of
your Recipes4Success license.

In this guide, you will see both Macintosh and Windows screen shots because
Recipes4Success works the same way on both platforms.

Once you begin using Recipes4Success, your primary reference source for
questions about Recipes4Success features is the Help system. To view the
Help, click the Help link on the right side of the Recipes4Success window.
You can find out more about the Help on page 41.

Recipes4Success is an online software training library available at
www.myt4l.com. The CD-ROM that accompanies Recipes4Success provides
additional resources and shortcuts to additional Recipes4Success content.

Macintosh:
G3 or higher
OS X 10.1 or higher
Internet Explorer 5 or higher, or
Safari 1 or higher
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Installing Recipes4Success - Windows
Quit all programs. Put the Recipes4Success CD into the CD-ROM drive.

The setup program will open. If Autorun is not enabled, open your CD-ROM
and double-click the Setup file.

At the Welcome dialog, click the Next
button.

At the Software License Agreement dialog,
read the license agreement and click the
Yes button.

At the Choose Destination Location
dialog, click the Next button.

At the CD Key dialog, enter your CD Key in
the field and click the Submit button.

Recipes4Success will be installed onto your
computer.

At the Finished dialog, click the Close
button.

To begin using Recipes4Success, go to the
Start menu, choose All Programs, choose
Tech4Learning, choose Recipes4Success,
and select Recipes4Success.
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Installing Recipes4Success - Macintosh

At the opening screen, click the Continue
button.

You will see the CD window.

Double-click the Install Recipes4Success
icon.

At the License dialog, read the license
agreement and click the Accept
button.

Quit all programs. Put the Recipes4Success
CD into the CD-ROM drive.

Double-click the Recipes4Success CD icon.

At the CD Key dialog, enter your CD Key in
the field and click the Continue button.

Recipes4Success will be installed onto your
computer.

At the final dialog, click the Quit button.

When the installation is finished, click the
Recipes4Success icon on the Dock to begin using
Recipes4Success.

At the Install Recipes4Success dialog, click
the Install button.
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Click the Create Account link.

You will see the account activation page.

Enter the activation key that came with your Recipes4Success license into the
Activation Key fields.

Activating a Recipes4Success Subscription
Open Recipes4Success.

On Macintosh: Click the Recipes4Success icon on the Dock.

On Windows: Go to the Start menu, choose All Programs, choose
Tech4Learning, choose Recipes4Success, and select Recipes4Success.

You will see the Recipes4Success Home page.

The Log in form is on the right side of the page.

Click the Submit button

At the New User Registration page, enter your contact information, your
email account for your username, and a password for your account.

Both your email address and password must be at least five characters in
length.
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The next time you want to use Recipes4Success, enter your Username and
Password on the Home page and click the Log in button.

When you are finished, click the Submit button.

Make a note of your username and password in a safe place. From now on, you
will only need to use your username and password to access your Recipes4Success
subscription.

After submitting your information, you will see the MyT4L Home page.
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The Recipes4Success Interface
The Recipes4Success window has panes on the left and right to provide
access to the most common activities. The center of the window displays the
content.

The Recipes pane has hyperlinks to go to the Recipes
and Snacks and to start creating My Books. Use the tabs
at the bottom of the pane to switch between levels 1, 2,
and 3.

The Tools pane has hyperlinks to go to the Lesson Library
and the online tools, including the Rubric Maker,
Graphic Organizer Maker, and Citation Builder.

The ProjectLearn pane has hyperlinks to useful articles on
integrating technology into the curriculum, including
step-by-step processes for designing and implementing
technology projects for students.

The Search pane lets you search for specific Recipes and
Snacks and provides hyperlinks to Recipes and Snacks you
have recently viewed.
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The Help pane has hyperlinks to the online help, resources
for helping you get the most out of Recipes4Success, and a
technology terms dictionary.

A set of hyperlinks at the top of the window gives you access to the
Recipes4Success Home page as well as the settings for your account.
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Using the Recipes
The Recipes are curriculum-based tutorials you can use to get an
introduction to a specific software tool.

Click the Recipes hyperlink in the Recipes pane.

You will see a list of software titles.

Click the software title you want to learn.

You will see a brief description of the content of the Recipe tutorial.

The list of Recipes
varies with your
subscription status,
level, and computer
platform.

Click the Click Here to Get Started hyperlink.

The Recipe will open in a new browser window.

The first page of the Recipe has a description of the tutorial and an image
from the tutorial.



12

Click the Click here to get started hyperlink.

You will see the next page of the tutorial.

Follow the instructions in the tutorial as you work in the application you are
learning.

The content window is small so you can you read the instructions while you
are working in the program you are learning.

Using the Navigation Tools
The navigation tools are at the bottom of the content window.

Click the Next Page button to move to the next page in the tutorial.

Click the Previous Page button to return to the previous page in the
tutorial.

Click the Table of Contents button to see a list of all of the
chapters in the tutorial.

You will see a list of all of the chapters in the Recipe.

Click one of the hyperlinks to jump to that chapter.

Click the Get Printable Version button to download a PDF
document you can print.

Note: Only Subscriber accounts have the ability to download and print PDF
documents. Student user accounts do not have the ability to print, and
student users will not see the Get Printable Version button.
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View Images Full-size
You can click on some of the images in the content window to see a larger
version of the image. This is useful if you need to see the image in greater
detail.

The cursor will change to a hand when you move it over an image you can
view at a larger size.

Click the image if you want to see a larger version of the image in a new
browser window.

Click the image to close this window.
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Using the Snacks
The Snacks are reference guides that you can use to learn a specific software
skill. The Snacks are perfect for just-in-time learning as you are working on a
project.

Click the Snacks hyperlink in the Recipes pane.

You will see a list of software titles.

Click the software title you want to learn more about.

You will see descriptions of the first five Snacks for the software title you
chose.

Click the numbers below the descriptions to see additional pages of Snacks.

Click the title of the Snack you want to read.



15

The Snack will open in a new browser window.

Follow the instructions in the Snack as you work in the application you are
learning.

The content window is small, allowing you read the information at the same
time you are working in the program you are learning.

To see the other Snacks available for the software title you are using,
click the Table of Contents button at the bottom of the Snack
window.

You will see a list of all of the Snacks available for the software title at this
level.

Click a hyperlink to view a Snack.

Click the Get Printable Version button to download a PDF
document you can print.

Note: Only Subscriber accounts have the ability to download and print PDF
documents. Student user accounts do not have the ability to print, and
student users will not see the Get Printable Version button.
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Arranging Content Windows
Recipes4Success allows you to work through Recipes and Snacks at the same
time you are working in the application you are learning.

When you open a Recipe or Snack, it will open in another browser window
called the content window.

Once the content window is open, minimize the main Recipes4Success
window.

On Windows, click the Minimize button in the upper right corner
of the main Recipes4Success window.

On Macintosh, click the Minimize button in the upper left corner
of the main Recipes4Success window.

Moving the Content Window
Click and drag the title bar of the content window to either the left or right
side of the screen.

If the application you are learning is not open, open it. If you are not sure
how to open the application, you will find instructions in the Introduction
section of every Recipe.

You can also open the Snack containing instructions for launching the
program.

When the application is open, resize the application window so that you can
see both the content window and the application window at the same time.
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Resizing the Application Window
Move the cursor to the lower right corner of the application window.
You will the resize cursor.

Click and drag to resize the application window.

On Windows, if you do not see the resize cursor, your application is
maximized and is taking up the entire screen. Click the Restore
Down button in the upper right corner.

The application window will no longer take up the whole screen, and you
will be able to resize the window.

When the window is the right size, click and drag the title bar at the top of
the window to move the application window next to the content window.
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Using the Levels
Recipes4Success provides tutorials and reference materials at three levels:

Level 1
• Early Technology Users
• Reading Level: Approximately 2nd Grade, 6-7 years old, Key Stages 1 and 2

Level 1 is written to the lowest reading level appropriate to the vocabulary of
a specific program. For example: Recipes and Snacks for Microsoft Publisher,
contain the words “Publisher” and “Publication”.

Simple language makes Level 1 an excellent choice for adults new to
computers, as well as second language students.

Level 2
• Intermediate Technology Users
• Reading Level: Approximately 5th Grade, 10 years old, Key Stages 3 and 4

Level 3
• Advanced Technology Users
• Reading Level: Approximately 8th Grade, 13 years old, Key Stages 5 and 6

Changing Levels
You can change levels while you are working in Recipes4Success.

There are three tabs on the bottom of the Recipes pane on the left side of the
screen.

The purple tab with one diamond is for Level 1, the green tab with two
diamonds is for Level 2, and the blue tab with three diamonds is for Level 3.

Click the tab for the level that you want to use.
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Taking a Proficiency Assessment

You can take a proficiency self-assessment to help determine which level you
should be using for any given application.

Click the Resources hyperlink in the Help pane.

You will see the Resources page.

Click the Which level should I use? hyperlink beneath the Proficiency
Assessment heading.

You will see the Proficiency Assessment page.

Click the name of the application you want to test your proficiency.
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You will see a series of fifteen self-assessment questions for the application
you chose.

Select a radio button to answer each question.

When you are finished, click the Submit button at the bottom of the page.

You will see the results page with a suggested level based on your self-
assessment.

To work through a tutorial, click the Go to Recipe hyperlink.

To learn specific skills, click the Go to Snacks hyperlink.
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The results of your proficiency assessments are stored in your account. To
view all of your proficiency assessments, click the My Account hyperlink at
the top of the page.

You will see the Account Settings page.

Click the Assessments hyperlink.

You will see a list of the proficiency assessments you have taken.
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Making a My Book
The My Books feature lets you create groups of up to ten Snacks that can be
used together in one content window or in one printed document. This is a
great way to make customized training materials or lessons.

The My Books feature is only available while you have an active subscription
to Recipes4Success. Log in to your Recipes4Success account. Type in your
username and password, and press the Log in button.

Click the My Books hyperlink in the navigation pane.

You will see the My Books page.

My Books contain Snacks from the level you are working in. The level is
displayed in the page title.

To make a new book, click the Book Title field.

Type a title for your book.

Click the New button.

You will see the Edit Books page.
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Click the Applications pull-down menu and select the
application you want to use.

You will see all of the Snacks for the application you chose.

Click the first Snack you want to use.

Click the Add button.

The Snack will be added to your My Book.

Use this process to add more Snacks to the Book.
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You can add Snacks from more than one application.

Use the Applications pull-down menu to choose another application. You
will see Snacks for this application.

Add additional Snacks you want to use in this Book.

You can change the order of Snacks in your Book. Click the Snack you want
to move.

Click the Move Up or Move Down arrow buttons to move the Snack to the
place you want it in the Book.

When you have finished, click the View Book button to look at your
book in the content window.

If you want to print your book, click the Print Book button.

Click the Print button to print the PDF.

A PDF file of your book will be created.

Click the Save button to save the PDF to your computer.

When you are finished editing your book, click the My
Books hyperlink in the Recipes pane.
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You will see your new book listed on the My Books page. Books will only
appear on the My Books page in the level in which they were created.

Click the Edit Book button to add or remove Snacks from a book.

Click the Rename Book button to change the name or icon for a
book.

Click the Delete Book button to delete a book.
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Filtering Programs
Recipes4Success has tutorials for more than 30 software tools. You can select
which applications you want to display when you log in to your account.
This makes it easier to browse for applications, and you will only receive
search results for applications you have selected.

After logging into your account, click the My Account hyperlink at the top
of the window.

You will see the Account Settings page.

Click the Program List hyperlink.

You will see a list of all the applications available in the Recipes4Success for
Windows.

If you are working on a Macintosh, click the Macintosh hyperlink. You will
see all the applications available for Macintosh.

Click the check boxes to deselect applications you do
not have access to.
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Be sure to select applications for all three levels.

When you are finished, click the Save Changes button at the
bottom of the window.

When you view an application list for the Recipes and Snacks, only
applications you have selected will be displayed.



28

Windows XP SP2 Security Settings

Windows XP Service Pack 2 introduced new security controls that may block
some Recipes4Success content. If you experience this, you can change the
settings in Internet Explorer so the content is not blocked.

If content is blocked, you will see the Information Bar dialog with a message
when you try to open a page.

Click the OK button.

There will be an Information Bar at the top of the browser window.

Click the right side of the Information Bar. You will see a menu of options.

Click Allow Blocked Content.

You will see a Security Warning dialog.

Click the Yes button.
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Go to the Tools menu and choose Internet Options.

You will see the Internet Options dialog.

Click the Advanced tab.

Scroll down until you see the Security settings.

Click the Allow active content to run in files on My Computer check box.

Click the OK button.

You will no longer receive a warning when you try to load pages in
Recipes4Success.
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Using the Rubric Maker
Rubrics are a highly effective way to assess student work. Rubrics can help
students understand what skills, knowledge, and behaviors are being
evaluated. You can use the Rubric Maker to create your own customized
performance assessment.

Open Recipes4Success.

You will see the MyT4L home page.

If you have a subscription, log in with your username and password. This will
allow you to save your rubrics and use or edit them in the future.

Click the Tools hyperlink on the left side of the page.

You will see the tools page.

Click the Rubric Maker hyperlink.

You will see the Rubric Maker options.

Click the Title field and type a title for the rubric.

Use the Level pull-down menu to choose the grade level you are teaching.

Click the New button.
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You will see the fields of the Rubric Maker. You can choose a topic and
component using the pull-down menus on the left, or create your own.
When you choose a topic and component, default text will appear in the
criteria fields on the right. You can add to or change this text.

To begin, use the Topic pull-down menu to choose the general topic you will
be assessing. Topics vary depending on the level you have chosen for the
rubric. Think about which topic you want to appear first in your rubric.

Use the Component pull-down menu to choose the specific skill for the
topic you want to assess. Once you have chosen the general topic,
components specific to that topic will appear.

You will see default text explaining the performance criteria for each level.

Edit the text in each of these fields to match the specific criteria you expect
students to complete in this project.
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To create customized content, type your own component in the Custom
Component field.

Type a description in the description field and type the proficiency
information for each level.

If you are also building a checklist, click the Checklist field and type
information for the checklist.

Continue adding information to each row to cover all of the skills you want
to assess. Use the pull-down menus to choose the topics and components,
and edit the default text to match your project goals.

To add a new row, click the Add a Row button.

This will add another row to your rubric.

It is a good idea to keep a rubric short enough to print on one page. Too
much information can overwhelm your students, and goals for a project can
be lost.

Editing Rubric Properties
If you are already using rubrics in your classroom, you probably have specific
words you use for the criteria headings. You can edit the rubric properties to
change these headings.

Click the Edit Rubric Properties button.

You will see the rubric properties.
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Click the Order pull-down menu to choose whether the criteria should be
displayed in ascending or descending order.

Click the Tier fields and type new text to change the labels for each
proficiency level.

Click the Edit Rubric button to continue working on the rubric.

Printing Rubrics
To view how your rubric will print, click the Print Rubric button.

You will see the print options.

Click the HTML link to view, print, and save the rubric using your Web
browser.

The rubric will open in a new window.

Go to the File menu and choose Print to make a master copy.

Go to the File menu and choose Save As to save this file to your computer.

If you have an active subscription, you will also see a PDF option.

Click the PDF link to view, print, and save the rubric using Adobe Reader.
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You will see the rubric in Adobe Reader.

Click the Save button to save the file.

Click the Excel link to view, print, and save the rubric as a spreadsheet using
Microsoft Excel.

You will see the File Download dialog.

Click the Save button to download the rubric to your computer as a
spreadsheet file. Click the Open button to open the rubric in Microsoft
Excel. Use Excel to make changes, save, and print the rubric.

Click the Finished Editing Rubric button to return to the Rubric Maker
home page.

You will see the rubric in the list.

Click the Print button to print a master copy.
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Using the Graphic Organizer Maker
Graphic organizers help students build a strong foundation of information
about a topic. You can use the Graphic Organizer Maker to create printable
worksheets your students can use to organize information, make connections
between ideas, and plan a project.

Open Recipes4Success.

You will see the MyT4L home page.

If you have an active subscription, log in with your username and password.
This will allow you to save your graphic organizers and use or edit them in
the future.

Click the Tools hyperlink on the left side of the page.

Click the Graphic Organizer Maker hyperlink.

You will see the Graphic Organizer Maker options.

Click the New button.

Click the radio button for the type of graphic organizer you want to create.

Click the title field. Type a title for the organizer.

Click the Instructions field. Type instructions students will follow to
complete the organizer.

To use a sample set of instructions, click the Add default instructions link.
You can edit these instructions to make them specific to your topic.
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When you are finished, click the Print Graphic Organizer button.

You will see save options.

Click the HTML link to view the organizer in your Web browser.

The organizer will open in a new window.

Go to the File menu and choose Print to make a master copy.

Go to the File menu and choose Save As to save this file to your computer.

If you have an active subscription, you will also see a PDF option.

Click the PDF link to view, print, and save the organizer using Adobe
Reader.

You will see the organizer in Adobe Reader.

Click the Close button in the corner of the window to close the PDF.

Click the Save button to save the file.

Click the Print button to print a master copy.
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Click the Finished Graphic Organizer button to return to the Graphic
Organizer home page.

You will see the organizer in the list of saved graphic organizers.

Click the Edit Graphic Organizer button if you want to make changes.
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Using the Citation Builder
The Citation Builder can help you cite media you are using in your
technology projects.

Open Recipes4Success.

You will see the MyT4L home page.

If you have an active subscription, log in with your username and password.
This will allow you to save your citations and use or edit them in the future.

Click the Tools hyperlink on the left side of the page.

Click the Citation Maker hyperlink.

You will see the Citation Maker page.

Use the Add a new record pull-down menu to select the type of resource you
are citing.

Click the New button.

You will see empty fields for the citation.

Enter information in each field for the resource you are citing.

Click the Create button.
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You will see the citation in the Records list.

Click the Edit button to change information in the citation.

Click the Delete button to delete the record.

Use the Add a new record pull-down menu to create another record.

Create all of the records for your citation list.

When you are finished, click the Save button.

You will see the options for saving the citation list.

Click the HTML link to view, print, and save the citation list using your
Web browser.

Click the Text link to have the citation list as a text file.
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Getting Help
You can find answers to questions about the Recipes4Success in the Help.

Click the Help hyperlink on the right side of the page.

A new content window will open with the Help information.

Click a hyperlink for the topic you want to learn more about.

You will see a Snack on the topic you chose.

Click the Home button to return to the list of Help Snacks.

When you are finished with the Help, click the Close button in the corner of
the content window.
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